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INTRODUCTION 
This User Guide is designed to serve as a brief overview to help you get started. There is also 
information available under the Help option in the various Contributor interface toolbars. If necessary 
you can access the Help by launching the Contributor interface from the System Tray and selecting Help 
> Help and Support. 

If you would like further instructions, please consult the Features list at 
http://support.colligo.com/Lists/Features/AllItems.aspx  where you will find a complete list of features 
by product along with instructions for use. You can find a number of screencasts on the support site that 
walk you through the main product features. The SharePoint support site can be synchronized with 
Colligo Contributor for access at any time, online or offline. Please follow the instructions on the home 
page at http://www.colligo.com/support/.  

Please send questions and feedback to support@colligo.com.  

  

http://support.colligo.com/Lists/Features/AllItems.aspx
http://www.colligo.com/resources/screencasts/
http://www.colligo.com/support/
mailto:support@colligo.com


  Colligo Contributor Add-In for Outlook 

23/09/2011 Copyright 2011 Colligo Networks, Inc. All rights reserved. 
Not to be reproduced without permission. Learn more at www.colligo.com. 

Page 3 of 19 

 

TECHNICAL REQUIREMENTS 
Systems Supported 

 Microsoft® Windows® 7 Home Premium; Professional or Ultimate 

 Microsoft® Windows® Vista Business; Enterprise or Ultimate 

 Microsoft® Windows® XP Home or Professional 

 Microsoft Office 2003 – 2010 (Office 2003 SP2 or later for InfoPath forms) 

 Internet Explorer 6.0 or later 

 SharePoint Server 2010, MOSS 2007 and SPS 2003; SharePoint Foundation and WSS (2.0 or 3.0); 
SharePoint 2010 Online (Office365) and BPOS 

 Consumes roughly 20MB of disk space, not including content 

 If you are running a previous version, the new version can be installed over top of the old 
version without an uninstall. This also preserves all of the cached content. 

Application Prerequisites 
 Microsoft® .NET framework 3.5 Runtime 

Outlook Add-in Prerequisites 
 Compatible version of Outlook (Outlook 2010, 2007 or 2003) 

 Office 2003 or Office 2007 Primary Interop Assemblies (depending on which version of Office is 
installed) 

 Microsoft Visual Studio 2005 Tools for Office Second Edition (VSTO 2005 SE) Runtime 

 Microsoft Visual C++ 2008 SP1 Redistributable Package 
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INSTALLING COLLIGO CONTRIBUTOR 
Colligo provides both an .exe installer and an .msi installer for Contributor.  

There are different installer packages dependent on which version of Office you have installed: 

 For 32-bit Office, use the x86 installer 

 For 64-bit Office, use the x64 installer 

EXE Installer 
This installer package is an executable file with the following key features: 

 Supports interactive install only (does not support silent install) 

 Automatically installs software prerequisites (downloaded from www.colligo.com) 

 Not customizable 

Interactive EXE Install 
NOTE: Microsoft Outlook must be closed for the installation to be successful.  

1. Double-click the installation file.  
2. Prerequisites are downloaded and installed. 
3. Enter your license key. 

Colligo Contributor can be set to launch at Windows Start Up. This enables the background 
synchronization to start automatically.  

Terminal Server Install 
For information on installing in a Terminal Server environment see the Colligo Contributor Terminal 
Server User Guide.  

Concurrent Version Installations 
Colligo does not support side-by-side installations, running multiple versions or different versions of 
Contributor.  

Version Reversion/Downgrading 
It is not possible to revert to an earlier version of Contributor after upgrading, as the database is often 
updated.  
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THE OUTLOOK ADD-IN 

Adding a Site to Outlook 
It is possible to add a site to Contributor in a number of ways, including: 

 Use the Connect to Outlook option in Internet Explorer 

 Site > Download Site menu option 

 Click the site selector drop-down and select Download Site… 

 Drag-and-drop a URL from Internet Explorer Into Contributor 

Internet Explorer Toolbar Connect to Outlook Button 

1. Navigate to a SharePoint List or Library in Internet Explorer. 
2. Click the yellow Connect to Outlook icon on the toolbar. 

 

Outlook launches, if it is not already running, and confirms that you wish to connect the library to 
Outlook. 

3. You may choose to connect the List Online or Cached. 

 

For more information, see Contributor Add-In Cached vs. Online. 

You may be prompted for credentials to connect to the SharePoint site. Use your default Windows 
credentials, or supply other specific credentials. 

 

If the site you are connecting to is an Office365 site, a prompt for Office365 credentials displays: 
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If the Connect to Outlook process starts on a page that does not relate to a SharePoint List, the 
following message displays:  

 

4. Click OK, then navigate to a list in IE and click Connect to Outlook again. 

Once Contributor has finished downloading the List definitions, the folders are made available in 
Outlook. Contributor builds out a tree for the subfolders of the selected document library. 
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Contributor Add-In Cached vs. Online 
Contributor Add-In functions in two modes: Online and Cached.  

If you attempt connect a list to Outlook that has already been synchronized in Cached Mode, Outlook 
displays the SharePoint View of the list. However, the list remains synchronized in Cached Mode. 

The Online and Cached views are presented below: 

Cached View 

 

Online View 

 

Online Mode 

Key functionality of Contributor Add-In operating in Online Mode: 

 Does not maintain a cache of data  

 Upload content to SharePoint with metadata Prompt 

 View the SharePoint site in Outlook 

 Navigate through SharePoint site using Outlook folder tree 

 Automatically extract Email metadata (To, From, Sent, Subject, etc.) 

Cached Mode 

Key functionality of Contributor Add-In operating in Cached Mode: 

 Content is cached providing offline access 

 Upload content to SharePoint with metadata prompt 

 Access and Edit existing SharePoint content including accessing metadata. 

 Automatically extract Email metadata (To, From, Sent, Subject, etc.) 
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Editing Content in Cached Mode 
Select the folder in Outlook to access the Contributor Add-In Cached-View of the List. The Cached view 
provides access to the content. Here you can work with your content and perform the actions below: 

 Open a document by double-clicking on the item 

 Right-click on an item to: 
o Edit the properties (metadata) of the item. 
o Open/Edit a document 
o Check Out; Check In; or  Discard Check Out 
o Rename content 
o Delete content 
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Creating New Content in Cached Mode 
New content can be created by selecting the New option. 

On SharePoint 2007and 2010 sites, content can be created based on content type templates: 
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UPLOADING EXISTING CONTENT 
Using Upload Documents Menu 
Existing content can be added to Contributor by selecting the Upload option: 

 

Contributor prompts for metadata when the document is uploaded. 
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Using Drag-and-Drop 
Emails can be uploaded to SharePoint by dragging-and-dropping direct from your Inbox into a folder 
connected to Outlook. Contributor automatically extracts email metadata (To, From, Sent, Subject, etc) 
to similarly named SharePoint columns (if they are defined). 

The .msg format maintains fidelity of the message, including attachments. A unique SharePoint filename 
is generated based on Sender, Sent, and Subject.  

 

Dragging from Desktop to Contributor Cached View 

Files or Folder structures can be uploaded to SharePoint by dragging-and-dropping direct from your 
Desktop (or My Computer) into the Contributor Cached View in Outlook. Contributor prompts for 
metadata, and uploads the files and folders to the selected library.   
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Dragging From Desktop to Outlook  

Files can be uploaded to SharePoint by dragging-and-dropping direct from your Desktop (or My 
Computer) into the Outlook folder tree. Contributor prompts for metadata, and uploads the file to the 
selected library.  

 

Dragging Email Attachments into Outlook  

Attachments can be uploaded to SharePoint by dragging-and-dropping direct from an email into the 
Outlook folder tree (or Contributor Cached View). Contributor prompts for metadata and uploads the 
file to the selected library.  
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Using Send-and-File 

You can automatically store a copy of sent mail using the Send & File command in the Colligo Send & 
File toolbar. 

Select the destination SharePoint location using the Colligo for SharePoint folders in the Outlook folder 
tree. Filing Advisor suggestions locations based or recently used folders or email conversation. 
Contributor automatically extracts email metadata (To, From, Sent, Subject, etc.) to similarly named 
SharePoint columns. 

The .msg format maintains fidelity of the message, including attachments. A unique SharePoint filename 
is generated based on Sender, Sent, and Subject.  
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Using the Copy Folder 

Folders and their contents (including sub-folders) from your Mailbox can be uploaded to SharePoint 
using the Copy folder command in the Colligo toolbar. 

A corresponding folder tree is created in SharePoint and the individual emails are uploaded. Contributor 
automatically extracts email metadata (To, From, Sent, Subject, etc.) to similarly named SharePoint 
columns. 

The .msg format maintains fidelity of the message, including attachments. A unique SharePoint filename 
is generated based on Sender, Sent, and Subject.  

 

 

Copying Existing Content in Cached View 
Existing content, files, or folder structures can be copied between SharePoint document libraries or 
folders by a drag-and-drop operation. A new copy of the files or folders is created in the destination 
location and Contributor prompts for metadata. In cases where the metadata structure in the 
destination library is different from the source library. Contributor makes a best effort to match and 
retain existing metadata values. 

  



  Colligo Contributor Add-In for Outlook 

23/09/2011 Copyright 2011 Colligo Networks, Inc. All rights reserved. 
Not to be reproduced without permission. Learn more at www.colligo.com. 

Page 15 of 19 

 

Emailing Content as an Attachment 

Uploading Attachments 

You can share content with other users by sending them a link (SharePoint URL) to the content rather 
than an attached file. When creating an email, there is a Contributor toolbar to upload an item and 
replace it with a link. 

 

Insert SharePoint URL 

You can share content from the cache with other users by using the Insert command. Insert Attachment 
formats the URL and inserts it at the top of the body of the email as if it had just been uploaded. Insert 
Text Link inserts the URL at the current cursor location for inline URLs. 
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Attachment Rules 

Contributor warns or prevents emails from being sent if the total size of attachments exceeds a defined 
limit. If this limit is exceeded then some attachments may be removed or uploaded to SharePoint and 
replaced with their URLs. The current limits can be seen with the Rules command. 

 

Sharing Content 

Copying SharePoint URL 

You can share content with other users by right-clicking on an item and selecting Copy SharePoint URL. 
The URLs for the selected item(s) are copied to your clipboard and can be pasted into applications, files, 
or emails. 

Dragging-and-Dropping 

Alternatively, for users that do not have access to the SharePoint site it is possible to drag-and-drop files 
or folder structures from the Contributor Cached View into an email, Windows folder, or other suitable 
applications. 
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DEFAULT METADATA AND PROMPTING BEHAVIOR 
Contributor allows you to specify default values for metadata. Default values can be set at a document 
library, or subfolder level. The default values support both inheritance and propagation.  

Using the Metadata Dialog 
A sample of the Default Metadata dialog is displayed below. The following table explains the function of 
the dialog. 

 

List Selector Panel The List Selector allows you to change the List or Subfolder you wish to work with. 

NOTE: The List selector is only visible if the dialog is access through the File menu. 

Default Value 
Settings 

Name The Display Name of the SharePoint column 

Value The default value to be applied. 

Inherited From Indicates where Contributor receives this value from. The ‘Inherit 
From’ column may take the following values: 

 SharePoint Column definition 

 <not inherited> 

Parent Object Name. This may be the name of a document library of 
parent folder. 

Apply To Indicates whether the default value may be inherited by a subfolder. 
The Apply To folder may take the following values: 

 This Folder and subfolders 

 This Folder only 

Add, Edit, and 
Remove 

These buttons allow you to work with the locally-defined default values.  

Multiple items can be selected for removal using the Windows standard Ctrl and Shift 
selection modifiers. 

Inherit propagating 
values from parent 
items 

This folder will inherit propagating values from the parent item. Values specified with ‘This 
Folder and subfolders’ are propagating values and may be inherited. 

When un-checking the option Contributor provides the option to copy inherited values 
locally. 

Clear locally-defined 
values on all child 
items 

When settings are applied with this values checked, child-items are reset to inherit values; 
any user-specified default values on child-items are cleared. 

 

1. List Selector Panel 
2. Default Value Settings 
3. Add, Edit, and Remove 
4. Inherit propagating values from 

parent items 
5. Clear locally defined values on all 

child items 
6. Prompting Behavior 

1 2 

3 

5 

6 
4 
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Prompting Behavior Modify the prompting behavior. The options are: 

 Always: The metadata prompt will be displayed when an item is added 

 Never: The metadata prompt will not be displayed when an item is added 

 According to application global settings: Prompting behavior is as defined in the 
View > Options dialog 

Child-items that are configured for inheritance will inherit this setting. 

ACCESSING THE DIALOG 

File Menu 

The File menu may offer different options depending on the elements of Contributor deployed. To 
access the Contributor Control Panel interface, double-click the Contributor icon in the system tray.  

   

Control Panel  

* When accessed through the File menu, the Default Metadata dialog includes the List Selector 
Panel. 
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SYNCHRONIZING CONTENT 
Contributor offers different user-configurable synchronization processes to ensure data is kept 
synchronized with SharePoint. Synchronization runs silently in the background allowing you to continue 
working with your documents. 

Automatic Synchronization Processes 

 

Synchronize on startup: Contributor synchronizes 
cached content when it starts 

Synchronize when list is viewed: When you 
navigate to a list the content is synchronized 

Synchronized when list is modified: Modifications 
include changes to the document or metadata 

Enable background synchronization: Contributor 
synchronizes content periodically. The default sync-
interval is 30 minutes. 

Manual Synchronization Processes 
You can manually start the Synchronize command in main toolbar or ribbon: 

 

Full Synchronization 

Several of the synchronization processes allow you to specify Full Synchronization. When Contributor 
performs a full synchronization, additional information is downloaded. This includes definitions for Sites, 
Lists, Views, and Content Types, plus other site content that may not be retrieved during other standard 
sync processes. 


